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ABSTRAKT

Bakalářská práce si bere za cíl popsat teorii týkající se síťové analýzy v geografických

informačních systémech a následně ji využít v praxi. Je vytvořen podrobný pracovní po-

stup tvorby síťové analýzy týkající se oblasti služeb extenze Network Analyst programu

ArcGIS. Pracovní postup je založen na reálné výstavbě tramvajových tratí v Liberci na síd-

liště Rochlice a na podkladech Dopravního podniku měst Liberce a Jablonce nad Nisou

a Magistrátu města Liberce. Je vytvořena dvojí analýza oblasti služeb pro samostat-

nou tramvajovou dopravu a kombinaci dopravy tramvajové a autobusové v této oblasti.

Nakonec je určena statistika časové dostupnosti jednotlivých zastávek.

KLÍČOVÁ SLOVA

Geografický informační systém, extenze Network Analyst, síťový dataset, oblast služeb,

Dopravní podnik měst Liberce a Jablonce nad Nisou

ABSTRACT

Bachelor work aims to describe the theory of network analysis in geographic information

systems and then use of it in practice. A detailed workflow is created. The workflow

includes generation of new network analysis, which relates to Network Analyst extension

focused on Service Area Analysis. The workflow is based on real tram lines construction

in Liberec Rochlice housing and documents from the Transportation Company of cities

Liberec and Jablonec nad Nisou and Liberec City Hall. A dual servise area analysis

is created, for a separate combination of trams and tram and bus services in this area.

Finally, the time availability analysis is determined for each tram and bus stop.
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ČVUT Praha ÚVOD

Úvod

Tématem této bakalářské práce je síťová analýza. Sítě jsou prakticky všude ko-

lem nás, silničními sítěmi počínaje, přes síť řek, železničními sítěmi konče. Sítě lze

definovat jako soubor lineárních prvků, které vytvářejí určitou strukturu nebo ob-

razec, po nichž se pohybují zdroje.

Možným příkladem takovéto sítě je například tramvajová trať. Odtud vychází

také cíl mé práce, a tedy aplikovat síťovou analýzu na příkladu výstavby tramva-

jové tratě na sídliště Rochlice v Liberci. Díky ochotě tamějšího dopravního ředi-

tele Dopravního podniku měst Liberce a Jablonce nad Nisou mi byla poskytnuta

podkladová data, jelikož je i v zájmu podniku prezentovat plánovanou výstavbu

všemi možnými dostupnými prostředky.

V práci si tedy kladu za cíl zpracovat analýzu pěší dopravní dostupnosti tramva-

jových zastávek (popřípadě i autobusových) v určených časových intervalech s výs-

lednou statistikou počtu obyvatel žijících v určené oblasti, jelikož mi byla poskytnuta

příslušná demografická data magistrátem města Liberec.

Na začátku práce bych se chtěla zaměřit na teoretický úvod do síťových grafů

a extenzi Network Analyst programu ArcGIS, v druhé části podrobně přiblížit pra-

covní postup v programu samotném. Program, který ke zpracování dat využiji,

je program ArcGIS verze 10, od kterého mám k dispozici extenzi programu Network

Analyst věnující se problematice síťových analýz. Jelikož není tato extenze na našem

studijním oboru prozatím využívána, chci můj pracovní postup zpracovat podrobněji

(doplněný několika grafickými ilustracemi), aby mohl případně sloužit jako podklad

pro výuku části této extenze týkající se přímo zjišťování oblasti služeb.

Jako výstup práce očekávám grafické zpracování pěších časových dostupností

se znázorněním počtu obyvatel žijících v daných lokalitách, jak formou grafu, tak ta-

bulky, pro co nejlepší přehlednost i pro laickou veřejnost.
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ČVUT Praha 1. TEORIE

1 Teorie

Teoretická část je zaměřena na vysvětlení základních pojmů spojených s jejich uži-

tím v praktickém příkladu (viz. následující kapitola Praktický příklad užití).

1.1 GIS

Geografický informační systém je složenina dvou slov:

∙ geografie

∙ informační systém

Geografie je věda zabývající se studiem Zemského povrchu. Slovo geografie po-

chází z řeckých slov geo - Země, graphein - psát. Geografie popisuje a analyzuje

prostorové vztahy mezi fyzikálními, biologickými a humánními jevy, které se vysky-

tují na Zemském povrchu. [1]

Informační systém (definice Clause a Schvill 1991) je soubor hardware a software

na získávání, uchovávání, spojování a vyhodnocování informací. Informační systém

se skládá ze zařízení na zpracování dat, systému báze dat a vyhodnocovacích pro-

gramů. [1]

Definice ESRI: Geografický informační systém (zkráceně GIS) integruje hard-

ware, software a data pro pořizování, správu, analýzu a zobrazení všech forem

geograficky referencovaných informací. GIS umožňuje zobrazit, pochopit, zkoušet,

interpretovat a vizualizovat data mnoha způsoby, které odhalí vztahy, vzory a trendy

v podobě map, globusů, zpráv a grafů. GIS umožňuje odpovědět na otázky a řešit

problémy při pohledu na vaše data tak, aby byly rychle pochopeny a snadno sdí-

leny. GIS technologie mohou být integrovány do jakéhokoli systému podnikového

informačního rámce. [2]
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ČVUT Praha 1. TEORIE

1.2 Teorie grafů

Pojem grafu je přirozeným prostředkem k formálnímu vyjádření párových vztahů,

tj. vztahů mezi dvojicemi nějakých objektů. Grafy mají obecně mnoho různorodých

aplikací.

Graf se skládá z tzv. vrcholů a tzv. hran. Množinu vrcholů značíme obvykle 𝑉 ,

množinu hran 𝐸 (od anglického edge). Hrana vždy spojuje dva vrcholy (ne nutně

různé) a je buď orientovaná, nebo neorientovaná.

U hran orientovaných rozlišujeme počáteční a koncový vrchol a říkáme, že hrana

vede z počátečního do koncového vrcholu. Počáteční vrchol hrany 𝑒 značíme 𝑃𝑣(𝑒),

koncový vrchol 𝐾𝑣(𝑒). Neorientované hrany chápeme jako symetrické spojení dvou

vrcholů a nerozlišujeme, který z obou vrcholů byl uveden dříve.

V obou případech říkáme, že hrana je incidentní (popř. inciduje1) s vrcholy,

které spojuje a také každý z těchto vrcholů je incidentní s touto hranou. Vztah inci-

dence lze formalizovat jako zobrazení 𝜀, které každé hraně přiřazuje dvojici vrcholů

(pro orientované grafy přiřazuje dvojici uspořádanou, pro neorientované grafy dvo-

jici neuspořádanou). Pokud hrana spojuje nějaký vrchol se sebou samým, nazýváme

ji smyčkou. Smyčka může být orientovaná nebo neorientovaná. Orientovaný graf

má všechny hrany orientované, neorientovaný graf má všechny hrany neorientované.

Existují i smíšené grafy, které mají oba druhy hran.

Obr. 1.1: Příklad orientovaného grafu [4]

1incidence = mat. vzájemná poloha dvou geometrických útvarů majících společnou část [3]
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ČVUT Praha 1. TEORIE

Obr. 1.2: Příklad neorientovaného grafu [4]

Grafy (orientované i neorientované) lze s výhodou znázorňovat kreslením (viz. ob-

rázky výše). Ostatně odtud dostaly jméno. Vrcholy obvykle kreslíme jako body

(kroužky), hrany jako čáry (křivky, úsečky, oblouky), které spojují příslušné dvojice

vrcholů. Je-li hrana orientovaná, značíme orientaci šipkou od počátečního ke konco-

vému vrcholu. [5]

Počátky teorie grafů jsou poměrně skromné. Na rozdíl od mnohých jiných mate-

matických disciplín, které vznikly z významných (většinou fyzikálních) problémů, při

vzniku teorie grafů často stály úlohy z rekreační matematiky (hlavolamy), v našem

případě se jedná například o síť cest.

Stručně řečeno si u těchto typů grafů vyznačíme křižovatky, rozcestí, konce

slepých uliček a jiná důležitá místa, která poté spojíme čarami reprezentujícími

komunikace, přičemž šipka na čáře označuje jednosměrnou komunikaci. Takovéto

zobrazování je velmi jednoduché a je možné předpokládat, že vzniklo už v počátcích

mapování. Pro více úloh nám stačí uvažovat jen grafické vyjádření. [6]

Obr. 1.3: Příklad grafického vyjádření komunikací [6]
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ČVUT Praha 1. TEORIE

1.2.1 Síťová analýza

Sítě jsou všude kolem nás (silniční a železniční sítě, sítě produktovodů, říční sítě

apod.). Sítě lze definovat jako soubor lineárních prvků, vytvářejí určitou struk-

turu nebo obrazec, po nichž se pohybují zdroje, obvykle slouží k transportu hmoty

a energie.

Síťové analýzy obvykle pracují s těmito komponentami:

∙ souborem zdrojů (např. které zboží se má rozvést)

∙ lokalitami nebo prostorem, kde jsou zdroje umístěny (např. sklady zboží)

∙ cílovými místy, kam jsou zdroje transportovány (např. sídla zákazníků odebíra-

jících zboží), nebo místy, kde jsou poskytovány určité služby (např. nemocnice)

∙ souborem pravidel nebo matematických vztahů popisujících způsob transportu

(např. průměrná rychlost vozidel)

Mezi hlavní typy sítí patří řeky, vlaky, silnice. Řeky tečou pouze jedním smě-

rem, je pro ně tudíž nejvhodnější orientovaná síť. Vlaky obvykle jezdí v obou smě-

rech, pro ně se tedy hodí nejlépe neorientovaná síť. Silnice mohou být orientované

nebo neorientované (jednosměrné nebo obousměrné) a obvykle obsahují smyčky,

takže se pro ně hodí některá z variant se smyčkami. Před aplikací počítačových me-

tod síťové analýzy je třeba uvážit, o jaký typ sítě se jedná. Nejobtížnější součástí

síťové analýzy je výběr nebo tvorba odpovídající a dostatečně podrobné sítě.

Obr. 1.4: Hlavní typy sítí [7]
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ČVUT Praha 1. TEORIE

Formát síťových grafů může být vektorový (častější případ) nebo rastrový (méně

často).

Typické funkce používané pří síťové analýze jsou funkce:

∙ pro trasování sítě (tracing) – v síti se hledá určitá trasa

∙ pro volbu optimální trasy (routing) – v lineární síti se hledá nejvýhodnější

trasa pro přepravu materiálu, osob nebo energie

∙ pro alokaci zdrojů (network allocation) – optimalizační funkce – území se roz-

děluje do zón, ve kterých jsou zabezpečovány určité služby

Trasování sítě (tracing) vyhledává určitou trasu v síti na základě kritérií stanove-

ných uživatelem. Např. správce elektronických zařízení může potřebovat v GIS zjistit

trasu mezi elektrickou rozvodnou a transformátorem situovaným nejblíže připravo-

vaného staveniště, aby si tak ověřil distribuční kapacitu sítě v příslušném vedení.

Dalším příkladem je vyhledávání vedení ve vodovodním systému, které s největší

pravděpodobností připadá v úvahu při zjištěné poruše potrubí.

Vyhledávání nejkratší nebo nejrychlejší cesty je nejčastějším případem optima-

lizace trasy. Nalezení nejrychlejší trasy z bodu A do bodu B po silnicích je rozho-

dujícím úkolem pro řízení záchranných služeb nebo obchodní účely. Existuje však

řada dalších úloh. Například vyhledávání nejefektivnější trasy školních autobusů

nebo nalezení nejrychlejší trasy mezi jednotlivými místy pro obchodní cestující.

Jestliže máme provést takovéto operace, nejdříve je nutné vytvořit odpovídající

síť. Součástí konstrukce sítě jsou detaily propojení jednotlivých silnic, informace

o jednosměrných ulicích, možnosti otáčení, omezení rychlosti a podobně. Síť musí

být vytvořena tak, aby byla schopna přijímat nové informace a bylo možno provést

změnu trasy. Některé prvky mohou představovat určitý problém – například mosty,

nadjezdy, kruhové objezdy, ulice s různým omezením přístupu na jednotlivých stra-

nách ulice, apod.
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ČVUT Praha 1. TEORIE

Alokace zdrojů vyžaduje definici center sítě nebo cílových bodů z hlediska pře-

pravy osob a nákladů. Například centry mohou být školy s maximální kapacitou

dětí, zdravotní střediska s kapacitou pacientů nebo obchodní domy s objemem

zboží. Algoritmy alokace používají tato centra jako modely, kolik lidí nebo zboží

lze přes ně přepravit. Výsledkem je mapa, která znázorňuje oblasti, které lze obslou-

žit z daného centra (školy, zdravotní střediska nebo obchodního domu). Algoritmy

obvykle pracují s alokačními linkami, které spojují jednotlivé prvky sítě s nejbliž-

ším střediskem a určují kapacitu. Obsahují přitom atributy jako jsou jednosměrné

ulice, překážky apod. Je-li například cílovým bodem tramvajová nebo autobusová

zastávka, je možno pomocí alokace zdrojů stanovit ve městě cílové body tak, aby byly

dosažitelné desetiminutovou chůzí. Při poruše vodovodní sítě lze optimalizovat roz-

místění cisteren s pitnou vodou v oblasti poruchy. Obdobně lze nalézt optimální

rozmístění požárních stanic ve městě, aj. [7]

1.3 Použitá data

1.3.1 ZABAGED

Základní báze geografických dat České republiky (ZABAGED) - je digitální geo-

grafický model území České republiky, který zobrazením geografické reality odpovídá

podrobnosti Základní mapy České republiky v měřítku 1:10 000. ZABAGED má cha-

rakter geografického informačního systému integrujícího prostorovou složku vekto-

rové grafiky s topologickými relacemi objektů a složku atributovou obsahující popisy

a další kvalitativní a kvantitativní informace o jednotlivých geografických objek-

tech. Obsah ZABAGED tvoří 123 základních typů geografických objektů členěných

do osmi tematických kategorií a více než 350 typů popisných atributů. Polohopisná

část obsahuje dvourozměrně vedené (2D) prostorové a popisné informace o sídlech,

komunikacích, rozvodných sítích a produktovodech, vodstvu, územních jednotkách

a chráněných územích, vegetaci a povrchu a o prvcích terénního reliéfu. Součástí

jsou i vybrané údaje o geodetických bodech na území České republiky. Výškopisná

část obsahuje trojrozměrně vedené (3D) prvky terénního reliéfu a je reprezentovaná

prostorovým 3D souborem vrstevnic.
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ČVUT Praha 1. TEORIE

Objekty jsou pravidelně celoplošně aktualizovány s využitím fotogrammetrických

metod, terénního místního šetření a vybrané typy objektů jsou aktualizovány prů-

běžně ve spolupráci s primárními správci těchto dat. Některé typy objektů obsa-

hují v atributové části tzv. identifikátory, které tvoří integrační klíč pro zjištění

podrobnějších údajů o geografickém objektu v databázi primárního správce dat.

Tím jsou vytvářeny předpoklady pro integraci ZABAGED v rámci informačního

systému veřejné správy.

ZABAGED využívá v souladu s nařízením vlády č. 430/2006 Sb., o stanovení geo-

detických referenčních systémů a státních mapových děl závazných na území státu

a zásadách jejich používání, geodetický referenční systém Jednotné trigonometrické

sítě katastrální (S-JTSK) a výškový systém baltský - po vyrovnání (Bpv). [8]

1.3.2 WMS služby

Web Map Service (dále WMS) je služba, která byla vytvořena z důvodu umož-

nění sdílení dat GIS v distribuovaném prostředí Internetu. Jedná se o nástroj nejen

pro GIS systémy, který zpřístupňuje informace ve formě map (rastrů). Výsledkem

požadavku např. GIS softwaru na WMS server jsou primárně obrazová data v nej-

různějších formátech (JPEG, TIFF, PNG, aj.), které zobrazují tematické geografické

informace (tematickou mapu - vrstvu). [9]

Základním principem WMS jsou vzájemné interakce a to stroj-stroj a stroj-

člověk. V nejvyšším vrcholu této komunikace je mapový server. Pokud podporuje

WMS službu můžeme hovořit o WMS serveru. Klient je potom software, který ko-

munikuje se serverem za účelem získání informací. K této komunikaci využívá Hyper

Text Transfer Protocol (HTTP), resp. jeho metody dotazů, jimiž jsou GET a POST.

Klient si poté zpracuje informace, které mu server zpřístupnil. Tyto informace po-

mocí definovaného uživatelského rozhraní zpřístupní uživateli. Jedná se o inter-

akci člověk-stroj (resp. uživatel-klient). Názornější vysvětlení naznačuje nadcházející

obrázek. [10]
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Obr. 1.5: Princip interakce WMS (člověk - stroj - stroj) [10]

Mezi poskytovatele těchto dat patří i geoportál INSPIRE (Infrastructure for spa-

tial information in Europe), který nabízí například vrstvu barevné ortofotomapy

s prostorovým rozlišením 50 cm nebo hranice správních celků - katastrálních území,

obcí, POÚ2, ORP3 a krajů.

1.4 Dopravní podnik měst Liberce a Jablonce n./N.

a.s.

Dopravní podnik měst Liberce a Jablonce nad Nisou, a.s. je akciová společnost,

jejímž rozhodujícím předmětem činnosti je silniční motorová doprava, provozování

dráhy a drážní dopravy, provádění (dopravních) staveb vč. jejich změn a provozování

autoškoly. [11]

Městské autobusové linky v Liberci, českém krajském městě se 105 000 obyvateli,

provozuje Dopravní podnik měst Liberce a Jablonce nad Nisou a.s. (do listopadu

2010 pod názvem Dopravní podnik města Liberce a.s.). Do roku 2008 se na provozu

podílela asi z 20% jako subdodavatel i divize MHD podniku ČSAD Liberec a.s.

Poprvé se autobusy v ulicích města Liberce objevily v roce 1927. První linka vedla

z Ruprechtic k radnici, kde lidé mohli přestoupit do dalších tramvají. Autobusovou

dopravu provozovalo město až do roku 1933, kdy ji prodalo soukromé společnosti.

Ne však natrvalo; o 6 let později, v souvislosti s připojením dalších obcí k Liberci,
2POÚ = pověřený obecní úřad
3ORP = obec s rozšířenou působností
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ji město přebralo zpět. Provoz pak přerušila až válka. Již 2 měsíce po osvobození,

od července 1945, byl provoz postupně obnovován, od srpna 1948 dokonce rozšiřován

(přibyla nová linka do Jablonce nad Nisou, v roce 1955 nahrazená tramvajovou tratí).

Roku 1960 autobusy převzaly dopravu po zrušených tramvajových tratích do Roch-

lic a Růžodolu. Centrálním bodem veškeré autobusové dopravy se stal v roce 1995

terminál Fűgnerova – moderní přestupní uzel, v roce 2008 upravený a modernizo-

vaný. [12]

Obr. 1.6: Slavnostní zahájení provozu dopravního podniku na Poštovním náměstí

v Rochlici v roce 1899 [13]

Od ledna 2010 Dopravní podnik města Liberce a.s. převzal na základě desetileté

smlouvy provozování městské hromadné dopravy (dále MHD) v Jablonci nad Nisou,

kterou však zpočátku provozuje s autobusy pronajatými od původního dopravce.

Z tarifního hlediska a z hlediska číslování linek a přepravních podmínek však zatím

zůstávají oba systémy MHD oddělené. 21. října 2010 se Dopravní podnik města Li-

berce a.s. přejmenoval na Dopravní podnik měst Liberec a Jablonec nad Nisou a.s.,

10. listopadu 2010 pak na Dopravní podnik měst Liberce a Jablonce nad Nisou a.s.

V současnosti (od září 2010) zahrnuje městská autobusová síť 48 linek (z toho

11 školních a 2 tzv.„obchodní“ , na kterých je přeprava zdarma).
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Centrálním bodem MHD je od ledna 1996 terminál Fűgnerova, kde kromě čtyř

autobusových linek staví všechny autobusy i tramvaje. Nejvytíženější jsou linky ob-

sluhující největší liberecká sídliště (především Rochlice). Kromě města samotného

autobusy městských linek obsluhují i několik okolních obcí. [12]

Obr. 1.7: Plán sítě MHD Liberec (stav k 12.12.2010) [14]
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Budoucnost MHD v Liberci - prioritou města Liberec je zavedení tramvajové dop-

ravy do sídliště Rochlice II. (sídliště „Dobiášova“). Tuto trať je možné vybudovat

a provozovat až po dokončení zdvoukolejnění části jablonecké tratě ve směru do cen-

tra Liberce. V souvislosti se zdvoukolejněním tramvajové tratě (dále TT) od doprav-

ního terminálu MHD ve Fűgnerově ulici do Vratislavic nad Nisou, jak je zakotveno

v územním plánu města Liberec, se v současnosti zpracovává dokumentace traso-

vání tratě přes ulici Mlýnská, s průchodem prostoru soukromých aktivit původně

zamýšleného obchodně zábavního centra PROMENADA (areál bývalé Textilany) –

jako přeložka tratě, dále napojení na již zrekonstruovaný úsek u zastávky „U Lomu“

a za výhybnou „Nová Ruda“ bude tramvajová trať pokračovat dvoukolejně kolem do-

mova důchodců až k zastávce „Lékárna“ . Z hlediska zachování výhod samostatného

drážního tělesa a dopravní bezpečnosti odtud povede trať jednokolejně v současné

ose, na samostatném drážním tělese; k tomu se zpracovává dokumentace pro zlep-

šení prostorových parametrů TT i přilehlého chodníku pro pěší, vedené zastavěnou

oblastí městského obvodu Vratislavice nad Nisou, kde se touto rekonstrukcí zároveň

zlepší dopravní i stavebně estetický charakter části města Liberec.

Ve spolupráci se Statutárním městem Liberec se taktéž připravuje dokumentace

na trasování novostavby TT na sídliště Rochlice II. Městem preferovaná varianta

vychází ze zastávky „U Lomu“ na meziměstské tramvajové trati a je vedena podél

východního okraje sídliště Broumovská, kde bude nutná i přeložka silniční komu-

nikace, mezi nově vznikající zástavbou „Pod Rušičkou“ a Horní Kopečnou, s odbo-

čením tratě ke stávající nejfrekventovanější zastávce „Dobiášova“ . Tato nová trať

se dokumentačně připravuje v rychlo-drážním charakteru. Podmínkou je však navá-

zání na zrekonstruovanou dvoukolejnou trať tak, aby bylo možné bezkolizní dopravní

propojení do centra Liberce v obou směrech. [11]
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1.4.1 Popis etap výstavby tramvajové tratě z terminálu

Fűgnerova na zastávku Dobiášova

0. etapa: Terminál Fűgnerova

∙ délka úseku: 330 m

∙ termín zprovoznění: srpen 2008

∙ celkové náklady: 61 173 000 Kč

Obr. 1.8: 0. etapa: Terminál Fűgnerova [13]

1. etapa: Fűgnerova - Mlýnská

∙ délka úseku: 340 m

∙ termín zprovoznění: listopad 2009

∙ celkové náklady: 104 478 000 Kč

Obr. 1.9: 1. etapa: Fűgnerova - Mlýnská [13]
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2. etapa: Mlýnská - Klicperova

∙ délka úseku: 250 m

∙ termín zprovoznění: listopad 2009

∙ celkové náklady: 61 425 000 Kč

3. etapa: Klicperova - U Lomu

∙ délka úseku: 950 m

∙ termín zprovoznění: listopad 2010

∙ celkové náklady: 121 487 000 Kč

Obr. 1.10: 3. etapa: Klicperova - U Lomu [13]

4. etapa: U Lomu - Ševčíkova

∙ délka úseku: 760 m

∙ termín zprovoznění: předpoklad 2011 - 2012

∙ celkové náklady: předpoklad 350 954 000 Kč
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5. etapa: Ševčíkova - Dobiášova

∙ délka úseku: 950 m

∙ termín zprovoznění: předpoklad po roce 2013

∙ celkové náklady: předpoklad 360 000 000 Kč [13]

Obr. 1.11: 4. a 5. etapa: U Lomu - Dobiášova [13]

1.4.2 Vymezení zájmového území - 4. a 5. etapy

Tramvajová trať do Rochlic výrazně odlehčí silnicím, které už přestávají náporu

dopravy stačit. Na sídlišti a v jeho okolí totiž žije kolem 16 000 lidí. V dopravní

špičce jezdí autobusy do Rochlic ve čtyřminutových intervalech. Ani to ale nestačí.

Jediným řešením je podle odborníků právě tramvaj, která má větší přepravní kapa-

citu a zácpy na silnicích ji nebrzdí. Výstavba tramvajové tratě na největší liberecké

sídliště potrvá do roku 2014 a bude stát zhruba 600 milionů korun. [15]

Výstavba tramvajové tratě probíhá po etapách se stavbou tratí po vlastním tě-

lese, přičemž je snaha o co nejmenší narušení běžného provozu (např. mimo období

výuky ve školách). Dalšími prvky výstavby jsou využití dotačního programu Evrop-

ské Unie, rekonstrukce části tratě do Jablonce nad Nisou a zlepšení stavu stávajících

komunikací.

Linky městské dopravy na sídliště Rochlice

∙ linka č. 12: Zelené Údolí – Fűgnerova – Pavlovice Letná
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∙ linka č. 23: Zelené Údolí – Fűgnerova – Růžodol Mlýn – Stráž nad Nisou

∙ linka č. 33: Kunratická sídliště – Sametová – Rochlice - Průmyslová zóna Jih

∙ linka č. 35: Fűgnerova – Sametová – Rochlice – Průmyslová zóna Jih

Linky městské dopravy na sídliště Broumovská

∙ linka č. 12: Broumovská – Krejčího - Fűgnerova – Pavlovice Letná

∙ linka č. 25: Broumovská – Fűgnerova – Ruprechtice náměstí – Ruprechtice

sídliště

∙ linka č. 33: Kunratická sídliště – Sametová – Rochlice – Průmyslová zóna Jih

∙ linka č. 35: Fűgnerova – Sametová – Rochlice – Průmyslová zóna Jih

∙ linka č. 5: Rybníček – Fűgnerova – Vratislavice nad Nisou

∙ linka č. 11: Viadukt – Fűgnerova – Vratislavice nad Nisou – Jablonec nad Nisou

[13]

Obr. 1.12: Znázornění tramvajové (červeně) a autobusové (modře) dopravy na síd-

liště Rochlice - rok 2009 [13]
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Obr. 1.13: Znázornění tramvajové (červeně) a autobusové (modře) dopravy na síd-

liště Rochlice - rok 2010 [13]

Trasa nové tramvajové tratě

∙ Fűgnerova, terminál MHD

∙ Mlýnská

∙ Textilana

∙ U Lomu

∙ Sametová

∙ Ševčíkova

∙ Krejčího

∙ Dobiášova
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Obr. 1.14: Znázornění tramvajové (červeně) a autobusové (modře) dopravy na síd-

liště Rochlice - rok 2013 [13]

Obr. 1.15: Rozmístění zastávek v úseku U Lomu - Dobiášova [13]

Nová tramvajová trať převezme obsluhu nejzatíženějších lokalit, umožní rychlé

spojení tramvají s centrem a především bez vlivu individuální dopravy, nabízí mož-

nost posílení nabídky míst v souvislosti s bytovou výstavbou mezi sídlišti Broumov-

ská a Rochlice a výhledově umožňuje kapacitní napojení lokality Vesec a Doubí.

Navíc jsou při výstavbě využity moderní technologie pro minimalizaci hluku, budo-

vání moderních zastávek s lepšími přestupními vazbami na autobusové linky, nové

bezbariérové tramvaje a větší ekologičnost.
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Zastávky autobusových linek v lokalitě mimo trasu tramvaje budou i nadále ob-

sluhovány autobusovými linkami, které doplňují páteřní tramvajovou trať. Zavedením

tramvajové tratě dojde ke snížení zatížení ulice Dr. Milady Horákové a tím zlepšení

průjezdnosti autobusových linek, nabízí se tedy možnost vzniku školních linek. [13]

1.5 ArcGIS Network Analyst

1.5.1 Co je Network Analyst?

S ArcGIS Network Analyst extenzí můžete odpovědět na otázky, jako jsou násle-

dující:

∙ Jaký je nejrychlejší způsob, jak se dostat z bodu A do bodu B?

Obr. 1.16: Nejrychlejší cesta z bodu A do bodu B [16]

∙ Jaké domy jsou dosažitelné do pěti minut od požární stanice?

∙ Jaké oblasti trhu se týká podnikání?
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Obr. 1.17: Zelené body představují sklady v různých městech, polygony před-

stavují jejich tržní oblasti, které jsou rozděleny do tří kruhů; zelené polygony

jsou dosažitelné kamiony do dvou hodin, oranžové do čtyř hodin a červené

do šesti hodin [16]

∙ Osoba chce navštívit obchod. Kterou pobočku by měl potenciální zákazník

navštívit, aby se minimalizoval cestovní čas?

∙ Které sanitky nebo hlídkové vozy mohou reagovat co nejrychleji na incident?

Obr. 1.18: Nejbližší policejní vozidla jsou přiřazena k mimořádným událostem;

počet policistů potřebných na každém místě závisí na závažnosti incidentu;

jsou generovány trasy a očekávané odezvy u každého vozidla [16]

∙ Jak může flotila vozidel, dodávek nebo servisních vozů zlepšit služby zákazní-

kům a minimalizovat náklady na dopravu?
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Obr. 1.19: Třem kamionům dovážejícím jídla z distribučních center jsou přiřa-

zeny obchody s potravinami a cesty do obchodů, které minimalizují náklady

na dopravu; kapacity vozidel, přestávky na oběd a omezení maximální dobou

jízdy jsou zahrnuty do analýzy [16]

∙ Kde může obchod otevřít pobočku s cílem maximalizovat podíl na trhu?

∙ Musí-li se společnost zredukovat, které pobočky má uzavřít, aby si udržela

co možná nejvyšší celkovou poptávku?

Podniky, veřejné služby a jiné organizace těží z extenze Network Analyst, protože

jim pomáhá provozovat svou činnost efektivněji a lépe se strategicky rozhodovat.

Tyto organizace tak mohou lépe pochopit dynamiku trhu, současnou i potenciální,

jakmile vědí, kdo má přístup k jejich výrobkům nebo službám.

Náklady na dopravu lze snížit optimálním řazením zastávek a nalezením nejkratší

cesty mezi zastávkami při zvážení několika omezení, jako jsou kapacity vozidla a ma-

ximální cestovní časy. Zákaznický servis je možno vylepšit prostřednictvím rychlejší

odezvy a pohodlnějším umístěním zařízení. Network Analyst usnadňuje pochopení

a řešení problémů této povahy.

Výzkumní pracovníci a analytici běžně využívají možností Network Analyst

pro určení nejméně nákladných cest mezi několika počátky a cíli cest.
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Origin-destination cost matice (dále OD cost matice), které Network Analyst vy-

tváří, se často stávají vstupy pro větší analýzy. Například odhad dopravního chování

často zahrnuje vzdálenosti, které lidé budou muset procestovat pro dosažení urči-

tého cíle. Tyto vzdálenosti sítě se používají v matematických výrazech na pomoc

při vytváření cestovních prognóz.

Obr. 1.20: Grafické znázornění OD cost matice [16]

OD cost maticová analýza počítá nejmenší náklady na cesty od počátků cest

do destinací. Výstupem jsou liniové prvky, které spojují počátek cesty s destinací.

Každý liniový prvek ukládá celkovou cenu nákladů cesty jako atributovou hodnotu.

Analytici často vezmou atributovou tabulku a použijí ji jako vstup pro aplikace li-

neárního programování.

Podobně poskytují některé analýzy v prostorových statistikách přesnější výs-

ledky, pokud jsou síťové vzdálenosti použity místo přímé vzdálenosti. Vezměme

pro příklad analýzy dopravních incidentů, které mají za cíl lokalizaci skupin do-

pravních nehod, zvýraznění jejich příčin a přijetí opatření ke snížení počtu nehod.

Vzhledem k tomu, že automobily cestují na pozemních komunikacích, je stanovení

skupin dopravních nehod se síťovými vzdálenostmi mnohem efektivnější než použí-

vání přímých vzdáleností. Než budete moci provádět analýzy sítě, aby jste odpově-

děly na otázky uvedené výše, je potřeba mít síťový datový soubor, který modeluje

dopravní sítě. [16]
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1.5.2 Co je to síť?

Síť je systém vzájemně propojených prvků, jako jsou hrany (linky) a spojovací

uzly (body), které představují možné trasy z jednoho místa na druhé. Lidé, zdroje

a zboží mají tendenci cestovat po síti: osobní a nákladní automobily cestují na silni-

cích, letadla létají na předem určených trasách, nafta teče v potrubí. Modelováním

možných cest v síti je možné provádět analýzy týkající se pohybu nafty, náklad-

ních automobilů nebo jiných látek na síti. Nejběžnější síťovou analýzou je nalezení

nejkratší cesty mezi dvěma body. ArcGIS seskupuje sítě do dvou kategorií: geomet-

rických sítí a síťových datasetů.

∙ Geometrické sítě (inženýrské a říční sítě)

Říční a inženýrské sítě, jako elektrické rozvody, plyn, kanalizace a vodovody,

umožňují cestovat po hranách pouze v jednom směru ve stejné době. Látka

v síti, například tok ropy v potrubí, si nemůže vybrat, kterým směrem bude pu-

tovat, cesta je spíše určena vnějšími silami: gravitací, elektromagnetismem, tla-

kem vody a tak dále. Inženýr může řídit tok látky tím, že kontroluje, jak vnější

síly působí na určitou látku.

Obr. 1.21: Inženýrské a říční sítě [16]

∙ Síťové datasety (dopravní sítě)

Dopravní sítě, jako jsou ulice, pěší a železniční sítě, umožňují cestovat po hra-

nách v obou směrech. Zástupce na síti, například řidič kamionu na silnici,

si může obecně svobodně rozhodovat o směru cesty, stejně jako o cíli.

Obr. 1.22: Dopravní sítě [16]
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∙ Multimodální síťové datasety

Síťový dataset je schopen modelování jednoho druhu dopravy, jako jsou silnice,

nebo multimodální síťe skládající se z několika druhů dopravy jako jsou silnice,

železnice a vodní cesty. [16]

1.5.3 Druhy vrstev síťové analýzy

ArcGIS Network Analyst umožňuje řešit běžné problémy v síti, jako je nalezení

nejlepší trasy přes město, nejbližšího vozidla záchranné služby nebo jejího zařízení,

identifikace oblasti služeb v určitém místě, obsluha sady zakázek vozovým parkem

nebo volba nejlepšího zařízení pro jeho otevření či zavření. [16]

Druhy vrstev síťové analýzy, kterými ArcGIS Network Analyst disponuje:

∙ trasa (route)

∙ nejbližší zařízení (closest facility)

∙ oblast služeb (service area)

∙ OD cost matice (OD cost matrix)

∙ rozvozní problém (vehicle routing problem)

∙ rozdělení míst(location-allocation)

1.5.4 Oblast služeb (Service area)

S Network Analyst najdete oblasti služeb v okolí libovolného místa v síti. Síťová

oblast služeb je oblast, která zahrnuje všechny dostupné ulice (ulice, které leží ve sta-

novené impedanci). Například 10-ti minutová oblast služeb pro zařízení zahrnuje

všechny ulice, které mohou být dosaženy do 10 minut od uvedeného zařízení.
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Obr. 1.23: Oblast služeb: Najděte všechny silnice dostupné do 10-ti minut z budovy

a poté tyto silnice ohraničte polygonem [16]

Co je dostupnost? Dostupnost odkazuje na to, jak snadné je jít na určité místo.

V ArcGIS Network Analyst může být dostupnost měřena z hlediska cestovního času,

vzdálenosti nebo jakékoli jiné impedance v síti. Hodnocení přístupnosti pomáhá od-

povědět na základní otázky, jako například, kolik lidí žije v 10-ti minutách jízdy

od kina? nebo kolik zákazníků žije v půlkilometrové pěší vzdálenosti od samoob-

sluhy? Zkoumání dostupnosti vám pomůže určit jaké je vhodné místo pro nové pod-

nikání. To vám také může pomoci určit, co je blízko existujícího podniku, což vám

napomůže promyslet další marketingová rozhodnutí.

Jeden jednoduchý způsob, jak zhodnotit dostupnost, je podle bufferové vzdále-

nosti kolem bodu. Například můžete zjistit, kolik zákazníků žije v okruhu 5-ti kilo-

metrů od místa pomocí jednoduchého kruhu. Avšak vzhledem k tomu, že lidé jezdí

po silnicích, nebude tato metoda odrážet skutečnou přístupnost k místu. Sítě služeb

vypočítané ArcGIS Network Analyst mohou překonat tato omezení určením pří-

stupných ulic do vzdálenosti pěti kilometrů od místa přes silniční sítě. Po vytvoření

můžete využít sítě služeb tak, aby jste viděli, co je podél přístupných ulic, například

najít konkurenční podniky v rámci 5-ti minutové jízdy.
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Obr. 1.24: Oblast služeb: Vygenerujte ulice, které jsou z budovy dostupné do deseti

minut [16]

Rozmanité soustředné oblasti služeb ukazují, jak se dostupnost mění s nárůstem

impedance. To může být použito například k demonstraci počtu nemocnic, které jsou

v 5-ti, 10-ti a 15-ti minutách dosažitelné ze škol. [16]

Obr. 1.25: Oblast služeb: Vygenerujte polygony zobrazující 5-ti, 10-ti a 15-ti minu-

tovou dostupnost [16]

1.5.5 Co je dataset?

Síťový dataset se dobře hodí k modelu dopravní sítě. Datasety jsou vytvo-

řeny ze zdrojových funkcí, které mohou zahrnovat jednoduché prvky (linie a body)

a otočky a ukládat spojení zdrojových vlastností. Při provádění analýzy pomocí

ArcGIS Network Analyst, se analýza vždy děje v síťovém datasetu.
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Modely síťového datasetu uliční sítě jsou uvedeny v grafice níže. Grafika upozor-

ňuje, že jednosměrné ulice, zákazy odbočení a nadjezdy (tunely) mohou být mode-

lovány. Analýzy, které jsou prováděny na síti, jako cesta od stanice 1 do stanice 2,

respektují tyto a další vlastnosti síťového datasetu.

Obr. 1.26: Modely síťového datasetu uliční sítě [16]

Abychom pochopili konektivitu a proč je důležitá, vezměme v úvahu, že funkce

si obvykle nejsou sebe navzájem vědomy. Například, jestliže se dvě linie protínají,

ani jedna si není vědoma té druhé. Podobně nemá bodový prvek na konci liniového

prvku žádné vlastní informace, které mu umožní o linii vědět. Nicméně, síťový data-

set udržuje informaci o tom, které funkce jsou prvky shodné. To má takovou politiku

konektivity, která se může upravit a dále definovat, které shodné prvky jsou skutečně

spojeny. Tímto způsobem je možné modelovat nadjezdy a podjezdy bez nutnosti

připojení silnice. Když je provedena analýza sítě tímto způsobem, tak řešitelé vědí,

jaké cesty podél sítě jsou proveditelné. [16]
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1.5.6 Algoritmy užité v Network Analyst

Výpočet oblasti služeb je založen na Dijkstrově algoritmu pro procházení sítě.

Jeho cílem je vrátit podmnožinu prvků spojených hran tak, aby byly ve stanovené

vzdálenosti sítě nebo mezními náklady, kromě toho může vrátit kategorizované linie

podle souboru zlomových hodnot, do kterých může hrana spadat. Řešitel oblasti

služeb může generovat linie, polygony obklopující tyto linie, nebo obojí. [16]

Dijkstrův algoritmus

Jedním z často používaných algoritmů pro nalezení nejkratší cesty grafem 𝐺

je Dijkstrův algoritmus. Provádí opakovanou relaxi hran, představuje modifikovaný

postup prohledávání do šířky. Patří do skupiny hladových algoritmů, které se opa-

kovaným hledáním lokálního minima snaží najít globální minimum.

Princip Dijkstrova algoritmu využívá postupného zpřesňování odhadu nejkratší

délky od výchozího uzlu 𝑠 do cílového uzlu 𝑘. Hodnota 𝑑[𝑣] je aktuální odhad nej-

kratší vzdálenosti k uzlu 𝑣, hodnota 𝑤[𝑢][𝑣] představuje ohodnocení hrany (𝑢, 𝑣),

𝑑[𝑢] je aktuální odhad nejkratší vzdálenosti k uzlu 𝑢. Pokud 𝑑[𝑢] + 𝑤[𝑢][𝑣] < 𝑑[𝑣],

hodnota 𝑑[𝑢] + 𝑤[𝑢][𝑣] představuje nový odhad nejkratší vzdálenosti 𝑑[𝑣]. Při rela-

xaci je v každém kroku vybrán takový vrchol 𝑢, který má nejmenší hodnotu 𝑑[𝑢].

Postup Dijkstrova algoritmu je následovný. Uzly budou uloženy v prioritní frontě

𝑄. Označme počáteční uzel grafu, od kterého bude hledání probíhat, jako 𝑆. Postup

lze rozdělit do několika kroků. V prvním kroku provedeme inicializaci vstupních

hodnot: 𝑑(𝑢) = 0, 𝑝(𝑢) = 0, pro 𝑢 ̸= 𝑣 𝑑(𝑢) = ∞. Všechny uzly setřídíme podle

hodnot 𝑑(𝑢) a umístíme do 𝑄.

Z prioritní fronty vybíráme uzel s nejmenší hodnotou 𝑑(𝑢). Při prvním průchodu

bude vybrán uzel 𝑠, který má jako jediný přiřazen vzdálenost 0. Tento uzel odebe-

reme z množiny 𝑄, označíme ho jako uzavřený. Provedeme relaxaci na všechny uzly
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s ním incidující a spočítáme odhad hodnoty 𝑑(𝑣). Tímto postupem každému incidu-

jícímu uzlu přiřadíme celkové ohodnocení (tj. sumu dílčích ohodnocení) od bodu 𝑠.

Pokud je nové ohodnocení uzlu menší než původní, nahradíme ho novou hodnotou.

V dalším kroku nalezneme uzel s minimální hodnotou 𝑑(𝑢), který není uzavřený,

a z něj provádíme relaxace na ostatní uzly. Stejným způsobem pokračujeme, do-

kud existuje nějaký otevřený uzel (tj. dokud 𝑄 není prázdná).

Obr. 1.27: Hledání nejkratší cesty prostřednictvím Dijkstrova algoritmu [17]

Výslednou nejkratší cestu rekonstruujeme zpětně od cílového uzlu tak, že před-

chozí bod nejkratší cesty tvoří uzel, ze kterého byla provedena relaxace, tj. před-

chůdce 𝑝. Uzly tvořící nejkratší cestu jsou uloženy pozpátku v matici předchůdců

𝑃 .

Obr. 1.28: Nejkratší cesta grafem vyjádřená jako posloupnost předchůdců [17]
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2 Praktický příklad užití

Program, který ke zpracování dat využiji, je program ArcGIS verze 10, od kterého

mám k dispozici extenzi programu Network Analyst věnující se problematice síťo-

vých analýz. Jelikož není tato extenze na našem studijním oboru prozatím využí-

vána, chci můj pracovní postup zpracovat podrobněji (doplněný několika grafickými

ilustracemi).

K dispozici máme data ZABAGED ZM10 (Základní mapa 1:10 000), přesněji

čtverec 03-14-22 (pokrývá oblast sídliště Rochlice), demografická data obsahují počty

obyvatel jednotlivých budov (k poslednímu sčítání lidí, domů a bytů z roku 2001).

Dále disponujeme rastrem se zákresem vyprojektovaných zastávek a podkladovým

ortofotem.

2.1 Nastavení souřadnicového systému

Nejprve si musíme nastavit souřadnicový systém u dat ZABAGED. Z toho důvodu

si otevřeme ArcCatalog, pravým tlačítkem klikneme na příslušný shapefiele (v našem

případě se jedná o Cesta.shp, Pesina.shp, SilniceDalnice.shp a Ulice.shp, které jsou

všechny typu line features).

Obr. 2.1: Okno ArcCatalogu
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Z rolety vybereme kolonku Properties..., poté záložku XY Coordinate System.

Zde se přes tlačítko Select proklikáme na požadovaný souřadnicový systém (v našem

případě Select → Projected Coordinate Systems → National Grids → Europe →

S-JTSK Krovak EastNorth.prj ). Po nastavení souřadnicového systému u všech sha-

pefilů zavřeme ArcCatalog.

Obr. 2.2: Okno Properties s nastaveným souřadnicovým systémem

2.2 Načtení shapefilů

Po spuštění programu ArcMap 10 načteme data: File → Add Data → Add

Data.... Postupně se proklikáme do složky se shapefily, které chceme načíst a přidáme

je tlačítkem Add.
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Obr. 2.3: Načtení dat

Obr. 2.4: Načtená data

2.3 Načtení podkladové ortofotomapy

Pro lepší orientaci a následnou vektorizaci si načteme podkladovou ortofotomapu.

Postupujeme obdobně jako při načítání dat: File → Add Data → Add Data.... Nás-

ledně se proklikáme do nejvyšší možné složky. Zde pokračujeme do složky GIS Ser-

vers → Add WMS Server. Ve vyběhnuvší tabulce vyplníme adresu [19]. Stiskneme

tlačítko Get Layers a potvrdíme.
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Obr. 2.5: Načtení WMS vrstvy

Dále musíme nastavit souřadnicový systém: pravým tlačítkem klikneme na při-

danou vrstvu ortofotomapy → Change Coordinate System a v následující tabulce

vybereme systém S-JTSK_Krovak_East_North a potvrdíme.

Obr. 2.6: Nastavení souřadnicového systému

Obr. 2.7: Načtená ortofotomapa
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2.4 Vektorizace

Vektorizace je v tomto případě nutná, jelikož nejsou data ZABAGED dostatečně

podrobná (například cestičky uvnitř sídlišť). Řečeno ve zkratce použijeme Editor,

v němž budeme přikreslovat jednotlivé cestičky, v našem případě do vrstvy Pesiny.

Obr. 2.8: Přiblížení plochy sídliště před vektorizací

Nejprve si musíme zaktivovat samotný Editor : Customize → Toolbars → Editor.

Na liště Editoru poté klikneme: Edit → Start Editing. Na pravé straně se poté zob-

razí okno Editoru, kde si vybereme vrstvu, do které budeme vektorizovat (v našem

případě Pesiny). Tvar kurzoru se změní na křížek, který se napojuje na ostatní linie.

Linii zakončujeme klávesou F2.

Obr. 2.9: Mód Editoru
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Po dokončení vektorizace vybereme z menu Editoru: Editor → Save Edits, poté

Editor → Stop Editing (uloží se změny, které jsme v Editoru provedli a zmizí pravé

okno Editoru).

Obr. 2.10: Přiblížení plochy sídliště před vektorizací

Následně je nutné vytvořit samostatnou vrstvu vektorizace - oddělit z vrstvy

Pesina nové vrstvy Pesina_2 (což jsou původní data ve vrstvě Pesina) a vektorizace

(což jsou nová data získaná vektorizací). V atributové tabulce je patrné, že se nová

data získaná vektorizací liší od těch původních tím, že hodnota ID je 0 (u původních

dat je hodnota nenulová). Nejprve si vytvoříme vrstvu vektorizace. Použijeme funkci

Selection By Attributes dostupné z menu: Selection → Select By Attributes.... Jako

vrstvu ze které vybíráme prvky je v našem případě vrstva Pesina a dotaz má podobu

𝐼𝐷 = 0.

Obr. 2.11: Výběr prvků vektorizace
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Po potvrzení se nám vyberou vektorizované prvky, abychom z nich ale vytvo-

řili novou vrstvu, musíme provést následující: pravým tlačítkem kliknout na vrstvu

Pesina → Data → Export Data. Exportujeme vybrané prvky (Export: Selected

Features, následně si vybereme umístění nové vrstvy a formát shapefile (*.shp).

Obr. 2.12: Cesta k exportování dat

Obr. 2.13: Export - výběr prvků vektorizace

Obdobně vytvoříme vrstvu Pesina_2 pouze s rozdílným atributovým dotazem:

𝐼𝐷 > 0.

2.5 Vytvoření vrstvy komunikace

Nyní si spojíme jednotlivé vrstvy Cesta, Pesina_2, SilniceDalnice, Ulice a vek-

torizace, abychom mohli později vytvořit síťový graf. Ke spojení vrstev využijeme

funkci Merge: Geoprocessing → Merge. Za vstupní vrstvy vybereme již zmíněné:
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Cesta, Pesina_2, SilniceDalnice, Ulice a vektorizace. Výstupní vrstvu si pojmenu-

jeme komunikace. Po potvrzení nám vznikne nová vrstva (chvíli to trvá).

Obr. 2.14: Funkce Merge - spojení více vrstev do jedné

2.6 Příprava na tvorbu síťového grafu

Nyní si upravíme atributovou tabulku. Vymažeme si sloupce, které nepotře-

bujeme (klikneme na ně pravým tlačítkem a vybereme Delete Field), zbydou nám

pouze tři sloupce FID, Shape, ID. Dále si tři sloupce vytvoříme: Add Field. Sloupce

pojmenujeme Metres, TF_Minutes a FT_Minutes, typ volíme Double.

Sloupce pojmenováváme takto, aby jsme si později ulehčili práci při tvorbě sí-

ťového datasetu (sám tyto sloupce pozná a vloží). Nyní musíme sloupce naplnit

hodnotami. U sloupce Metres použijeme funkci Calculate Geometry..., kde zadáme,

že chceme vypočítat délku v metrech.

Obr. 2.15: Vzhled atributové tabulky po přidání nových sloupců, před naplněním
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Obr. 2.16: Výpočet délky linií

U sloupců TF_Minutes a FT_Minutes postupujeme stejně (stejný výpočet),

jelikož je čas projití linie tam i zpět stejný, přičemž počítáme s průměrnou rych-

lostí chůze 4,5 km/h (což je 75 m/s) [18]. Hodnotu získáme pomocí funkce Field

Calculator..., kde se jedná o výpočet: 𝑇𝐹_𝑀𝑖𝑛𝑢𝑡𝑒𝑠 = 𝑀𝑒𝑡𝑟𝑒𝑠/75. Stejně získáme

i hodnotu FT_Minutes.

Obr. 2.17: Výpočet času potřebného k projití linie

Obr. 2.18: Výsledná podoba atributové tabulky vrstvy komunikace
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2.7 Zapnutí extenze Network Analyst

Abychom mohli vytvářet síťové analýzy, musíme mít zapnutou extenzi Network

Analyst. V menu volíme: Customize → Extensions, kde zaklikneme extenzi Network

Analyst.

Nyní si ještě musíme zapnout samotné menu této extenze: Customize → Toolbars

→ Network Analyst. Nyní máme možnost vytvářet síťové analýzy, ale když roz-

kliknete roletu Network Analyst, tak nejsou analýzy aktivní, jelikož ještě nemáme

vytvořen síťový dataset.

2.8 Tvorba síťového datasetu

Abychom mohli vytvořit síťový dataset, jsme si předem vytvořili vrstvu komu-

nikace. Nyní si zapneme okno ArcCatalogu.

Obr. 2.19: Zapnutí programu ArcCatalog přímo v programu ArcMap - umístěn

na pravé straně

V ArcCatalogu si najdeme naši vrstvu komunikace a klikneme na ni pravým

tlačítkem - z rolety si vybereme možnost New Network Dataset. Následně se nám

zobrazí průvodce tvorby síťového datasetu. Nejprve jsme dotázáni k zadání názvu

datasetu - v našem případě komunikace_network_dataset.

46



ČVUT Praha 2. PRAKTICKÝ PŘÍKLAD UŽITÍ

Obr. 2.20: Zadání názvu síťového datasetu

Následně zaklikneme, že nechceme vytvářet žádné otočky - pro pěší chodce

to nemá význam.

Obr. 2.21: Zadání otoček

Dále nastavíme konektivitu v námi tvořené síti, klikneme tedy na tlačítko Con-

nectivity....

Obr. 2.22: Nastavení konektivity
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Poté zvolíme možnost Any Vertex (implicitně je nastavena možnost End Point),

jelikož tato možnost vytvoří uzly na všech místech, kde se stýkají dvě linie (oproti

implicitní volbě, která vytvoří uzly pouze na koncích linií).

Obr. 2.23: Nastavení konektivity - Any Vertex

V dalším kroku průvodce nastavíme, že nechceme modelovat nadmořskou výšku

(pro náš případ modelování je výška nepotřebná).

Obr. 2.24: Nastavení užití nadmořské výšky

Následující krok je již předvyplněn, jelikož jsme si chytře pojmenovali sloupce

atributové tabulky Metres, TF_Minutes a FT_Minutes. Zde jsou vybrány sloupce,

které se na analýze budou využívat.

48



ČVUT Praha 2. PRAKTICKÝ PŘÍKLAD UŽITÍ

Obr. 2.25: Předvyplněná tabulka hodnotami ze sloupců atributové tabulky

Obr. 2.26: Jako defaultní volba pro následné síťové analýzy je volena hodnota

Minutes

Obr. 2.27: Po kliknutí na tlačítko Evaluators... jsou opět předvyplněné hodnoty

pro metry
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Obr. 2.28: Po kliknutí na tlačítko Evaluators... jsou opět předvyplněné hodnoty

pro minuty

Další krok je pouze informativní, že nechceme nastavit směry jízdy apod. (u chodců

nepotřebujeme - neexitují jednosměrné ulice pro chodce apod.).

Obr. 2.29: Nastavení směrů jízdy

V posledním kroku se nám zobrazí sumář všech hodnot, které jsme v průběhu

průvodce nastavili. Průvodce ukončíme tlačítkem Finish.

Obr. 2.30: Závěrečný sumář zadaných hodnot - 1. část
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Následně jsme dotázáni, zda chceme novou síť vybudovat, což potvrdíme.

Obr. 2.31: Dotázání na vybudování nové sítě

Nakonec potvrdíme, že chceme přidat všechny použité třídy prvků. Výsledkem

jsou vrstvy komunikace, komunikace_network_dataset (liniová vrstva hran) a komu-

nikace_network_dataset_Junctions (bodová vrstva uzlů).

Obr. 2.32: Výsledek tvorby síťového datasetu

2.9 Georeferencování podkladu projektu

Abychom mohli provést síťovou analýzu, potřebujeme zadat souřadnice jednotli-

vých zastávek - Facilities. Jelikož se mi nepodařilo získat přesné souřadnice, ale pouze

nákres se znázorněnými lokacemi zastávek [13], je nutné ho natransformovat.

Nejprve si musíme zapnout příslušný toolbar: Customize → Toolbars → Geo-

referencing.
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Obr. 2.33: Toolbar Georeferencing

Obdobně jako přidáváme vrstvy, přidáme rastr, v našem případě tram_zast.jpg,

který budeme georeferencovat. Při přidávání vyběhne tabulka, zda chceme vytvořit

pyramidy, což potvrdíme.

Obr. 2.34: Dotaz na vytvoření pyramid

Nyní přejdeme k samotnému georeferencování. Klikneme pravým tlačítkem myši

na ikonu rastru a zobrazíme si ho na obrazovku - Zoom To Layer. Nyní klikneme

na ikonu Add Control Points a začneme spojovat identické body v rastru a na pod-

kladu.
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Obr. 2.35: Ikona Add Control Points

Nejdříve klikneme na rastr (zelený křížek), pak na cílovou mapu - ortofoto (čer-

vený křížek). Po každé dvojici bodů se rastr upravuje. V mém případě stačilo zadání

dvou kontrolních bodů.

Obr. 2.36: Přehled kontrolních bodů
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Obr. 2.37: Výsledek georeferencování

2.10 Vytvoření oblasti služeb

Nyní máme již volbu New Service Area z menu Network Analyst aktivní. Po jejím

spuštění se v obsahu vrstev zobrazí další vrstva pojmenovaná Service Area.

Obr. 2.38: Zaktivovaná volba New Service Area
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Obr. 2.39: Nová vrstva Service Area

Následně musíme zadat jednotlivé tramvajové zastávky podle připraveného rastru.

V menu Network Analyst klikneme na ikonu, která nám zobrazí podrobné okno

Service Area (zobrazí se nalevo od obsahu vrstev), kde klikneme na vrstvu Facili-

ties, poté v menu Network Analyst klikneme na ikonu Create Network Location Tool

a klikáním na dataset vložíme jednotlivé zastávky tak, aby byly obsaženy ve žlutých

kruzích (v našem případě to je pět zastávek).

Obr. 2.40: Zadání zastávky uvnitř žlutého kruhu
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Obr. 2.41: Přidané zastávky - Facilities

Nyní je potřeba nastavit parametry analýzy - klikneme pravým tlačítkem myši

na Service Area → Properties....

Obr. 2.42: Cesta k nastavení oblasti služeb

Nás zajímají dvě záložky - Analysis a Polygon. Nejprve začneme záložkou Ana-

lysis. Zde nastavíme Impedance: Minutes, Default Breaks: 3 6 9 12 15, což nastavuje

hranice polygonů (tedy 0 - 3 minuty, 3 - 6 minut, atd.). Ostatní nastavení pone-

cháme.
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Obr. 2.43: Nastavení záložky Analysis

Nyní nastavíme záložku Polygon Generation. Zde nastavíme Polygon Type: Ge-

neralized, jelikož chceme vytvořit polygony, které lépe pokryjí zájmovou oblast. Dále

nastavíme hodnotu Trim Polygons na 100, čímž rozšíříme oblast kolem komunikací

o 100 metrů. Poté nastavíme oddíl Multiple Facilities Options na Merge by break

value, což nám propojí polygony z více zastávek, které se stýkají. Nakonec nastavíme

Overlap Type na Rings, což je vhodnější pro následující statistiky.

Obr. 2.44: Nastavení záložky Polygon generation

Nyní můžeme spustit samotné vytvoření polygonů, které provede tlačítkem Solve

z menu Network Analyst.
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Obr. 2.45: Ikona pro spuštění vytvoření polygonů

Obr. 2.46: Výsledné oblasti služeb

2.11 Výpočet statistik

Nyní budeme povětšinou používat funkce, které jsme si již objasnili, postup

bude tedy stručnější. Nejprve si načteme vrstvu BudovaBlokBudov.shp, zobrazující

zástavbu a vrstvu obyvatelstva csu_bud_pnt.shp, která obsahuje bodovou vrstvu

budov obsahující data o počtu obyvatel jednotlivých budov (ze sčítání lidí, domů

a bytů z roku 2001).
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Obr. 2.47: Načtené vrstvy BudovaBlokBudov a csu_bud_pnt

Dále si vytvoříme vrstvu zobrazující zájmové území. Nejprve si načteme WMS

vrstvu zobrazující katastrální území [20]. Tu poté zvektorizujeme (například opět

do vrstvy Pešiny) a poté novou linii exportujeme jako liniovou vrstvu Rochlice_u_Li-

berce. Pro další práci ale potřebujeme mít tuto vrstvu ve formě polygonu, což prove-

deme funkcí Feature to Polygon: ArcToolbox → Data Management Tools → Features

→ Feature to Polygon.

Obr. 2.48: Nastavení funkce Feature to Polygon
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Nyní si musíme uložit jednotlivé polygony jako jednotlivé vrstvy, abychom mohli

provádět další analýzy. Vybereme polygony jeden po druhém a exportujeme je zvlášť

jako nové vrstvy Polyon0_3 až Polygon12_15 (celkem tedy pět polygonů).

Následně využijeme funkci Clip: Geoprocessing → Clip, kde nastavíme Input:

na vrstvu, kterou chceme ořezat, např. csu_bud_pnt a za Clip feature: nastavíme

vrstvu Rochlice_u_Liberce_polygon, podle které budeme ořezávat. Vznikne tedy

vrstva obsahující pouze body, které ležely v polygonu. Obdobně ořežeme vrstvy Bu-

dovaBlokBudov, komunikace, Service Area∖Facilities, Polygon0_3 až Polygon12_15.

Dále využijeme funkci Select by Location: Selection → Select By Location....

Obr. 2.49: Funkce Select By Location s nastavenými parametry, které vyberou body

vrstvy clip_csu_bud_pnt, které protínají polygon Polygon0_3

Po vybrání bodů náležících určitému polygonu otevřeme atributovou tabulku

clip_csu_bud_pnt, kde si zaklikneme zobrazení pouze vybraných prvků - Show se-

lected records, klikneme pravým tlačítkem myši na sloupec celkem → Statistics...,

načež se nám zobrazí tabulka, která v kolonce Sum: zobrazuje počet osob bydlících

ve vybraném polygonu. Takto provedeme statistiku pro všechny polygony.
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Obr. 2.50: Cesta k funkci Statistics...

Obr. 2.51: Statistika zobrazující počet lidí žijících v pěší dostupnosti 0 až 3 minut

od tramvajové zastávky

Na závěr celý postup zopakujeme (úplně od začátku) pro analýzu oblasti služeb

s tím rozdílem, že přidáme další zájmová zařízení, tedy přidáme k tramvajovým

zastávkám ještě autobusové zastávky.
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Závěr

Cílem mé práce bylo vypracovat síťovou analýzu pro oblast sídliště Rochlice

a v té souvislosti vypracovat pracovní postup extenze Network Analyst – konkrétně

oblast služeb, což se mi podařilo.

V pracovním postupu jsem se snažila o co nejpodrobnější postup, aby bylo jed-

noduché ho případně zopakovat. V postupu jsem také využila několik poznatků

z předchozích předmětů věnovaných programu ArcGIS (např. georeferencování, vek-

torizace, transformace, . . . ), což naznačuje, že by výuka této extenze mohla volně

navazovat na naše předchozí studium.

Pokud se jedná o zpracování samotné analýzy, tak jsem narazila na drobné pro-

blémy. Po vytvoření polygonů, které zobrazují časovou dostupnost, se u zastávek

Ševčíkova a Krejčího při užití sítě s vlastními vektorizovanými liniemi zobrazovaly

hranice polygonů dle mého názoru nepředvídatelně. Polygony se oproti předpokladu

nelogicky přibližovaly k zastávce viz. následující obrázek.

Obr. 2.52: Zobrazení špatné tvorby polygonů v oranžově zvýrazněné oblasti

Při hledání problému jsem zjistila, že se při tvorbě síťového datasetu (tedy hran

a uzlů komunikací) netvoří na všech kříženích uzly, i když bylo nastaveno pravidlo

Any Vertex, což způsobilo zmíněné problémy.
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Abych mohla tuto chybu opravit, využila jsem funkce Topology, kdy jsem kon-

trolovala vzájemně nepřichycené a nedotažené či duplicitní linie. Ale ani tato oprava

nebyla dostačující. Následně jsem musela vizuálně kontrolovat místa, kde se podle

síťového datasetu uzly nevytvořily a takové místo znovu editovat. Po této opravě

už proběhl výpočet oblasti služeb dle předpokladů. Důvod, proč nedošlo k tvorbě

uzlů, si vysvětlit nedokážu.

Výsledkem je dvojí analýza pro samostatné tramvajové zastávky (Příloha A)

a poté pro zastávky tramvajové a autobusové (Příloha B), které obsluhují oblast

sídliště Rochlice. Jako směrodatnou uvažuji variantu, která využívá obojí dopravní

prostředky, jelikož tím lépe prezentuji nastalou situaci. A tedy, že 25% obyvatel

sídliště bydlí v pěší dostupnosti do 3 minut (3480 osob), 59% obyvatel do 6 mi-

nut (7922 osob), 15% obyvatel do 9 minut (2086 osob) a nakonec 1% do 12 minut

(202 osob). Posouzení o kvalitě takovýchto dat je na dopravním podniku, ale já se

osobně domnívám, že vzhledem k velikosti sídliště (celkem 13690 osob) je tato do-

stupnost vyhovující.
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